UCOP Budget Development System
Training for FY16-17 Budget
<table>
<thead>
<tr>
<th>Topics</th>
<th>Est. Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Module 1: Budget Development System Overview</strong></td>
<td></td>
</tr>
<tr>
<td>Background, Purpose, and Process map</td>
<td>~5 mins</td>
</tr>
<tr>
<td><strong>Module 2: Budget Development System Tools</strong></td>
<td></td>
</tr>
<tr>
<td>Part 1: Navigation</td>
<td>~15 mins</td>
</tr>
<tr>
<td>Part 2: Demo and Exercises</td>
<td>~60 mins</td>
</tr>
<tr>
<td>• Payroll</td>
<td></td>
</tr>
<tr>
<td><strong>Break</strong></td>
<td>~10 mins</td>
</tr>
<tr>
<td>• Non-Payroll</td>
<td>~25 mins</td>
</tr>
<tr>
<td>• Summary (Read-Only) Tabs</td>
<td>~10 mins</td>
</tr>
<tr>
<td>• Budget Distributions and Additional System Features</td>
<td>~15 mins</td>
</tr>
<tr>
<td>Part 3: Reports</td>
<td>~25 mins</td>
</tr>
<tr>
<td>Part 4: Maintenance</td>
<td>~5 mins</td>
</tr>
<tr>
<td><strong>Module 3: Budget Development System Help</strong></td>
<td></td>
</tr>
<tr>
<td>Technical Assistance &amp; Additional Resources</td>
<td>~5 mins</td>
</tr>
<tr>
<td><strong>Module 4: Questions &amp; Answers</strong></td>
<td>~5 mins</td>
</tr>
</tbody>
</table>
Module 1: BDS Overview
Module 1: BDS Overview

Background & Purpose

What is Budget Development System?
- Budget Development System is also known as BDS
- It was implemented in 2012 as a web-based collaborative budgeting interface to facilitate the UCOP annual budget planning and approval process

Why do we use BDS?
- Consistency
  - All budget data are entered on a common system with consistent format
  - The system automatically calculates and rolls up the inputted budget amounts from each financial accounting unit (FAU) to consolidated levels (such as departments, subdivision, division, and organization)
- Transparency
  - Budget plans are reflected transparently by units, departments, subdivisions, and divisions who commit to how resources will be spent
  - Adjustments made on purposed budgets are clearly shown in the system for units to view
- Accountability
  - BDS budget data and general ledger actual data are fed into BDS reports to help account managers monitor variances between budget versus expenses
Module 1: BDS Overview

Background & Purpose (cont’d 1)

- When is BDS used/How often is BDS used?
  - It is most heavily used by units and departments during the UCOP annual budgeting process from roughly March to June each year
  - UCOP Budget Office updates selected material budget changes in BDS throughout the year
  - BDS reports are used all year round to help monitor variances between budget versus expenditures
Module 1: BDS Overview

Process Map

1. Units and Departments enter and submit next year’s budget data to Division Heads

2. Division Heads review and approve next year’s budget data and submit to the UCOP Budget Office

3. UCOP Budget Office reviews, makes any adjustments, and approves next year’s budget data

4. UCOP Budget Office consolidates next year’s approved budget and prepares for the Regents Report

5. UCOP Budget Office implements next year’s budget
Module 2: BDS Tools
Module 2: BDS Tools
Learning Objectives

Part 1: BDS Navigation
- Log On and Log Off
- Workflow Hierarchy
- Workflow States
- Toolbar Functions

Part 2: BDS Demo & Exercises
- Payroll
  - Payroll Entry Tab
  - Payroll Summary Tabs
  - Payroll Report Divisional Tab
- Non-Payroll
  - Supplies & Expense Permanent & Temporary Tabs
- Summary (Read-Only) Tabs
  - Account Budget Tabs
  - Budget Office 1 & Budget Office 2 Tabs
- Budget Distributions
  - By Project
  - By Quarter
- Additional System Features
  - Forecast & Forecast Report Tabs
  - Reset
  - Annotations/Comments
  - Ownership Management
Module 2: BDS Tools
Learning Objectives (cont’d 1)

- BDS Dataflow Process Map

- Total Budget shown on Summary (Read-Only) Tabs:
  - Account Budget Tabs
  - Budget Office 1 Tabs
  - Budget Office 2 Tab

- Enter Payroll Budget in:
  - Payroll Entry Tab
  - Payroll Summary by Org Tab

- Enter Non-Payroll Budget in:
  - Supplies & Expense Perm Tab
  - Supplies & Expense Temp Tab
Module 2: BDS Tools
Learning Objectives (cont’d 2)

Part 3: BDS Reports
- Summary Report
- Budget Comparison Report
- Variance Report
- Object-Code List
- Report Export
- Adhoc Package

Part 4: BDS Maintenance
- Data Load & Refresh
- Organizational Changes
- New Account Setups
- New Fund Setups
Module 2: BDS Tools
Part 1: Navigation
Module 2: BDS Tools
Part 1: Navigation

- Log on to BDS
  - Open Mozilla Firefox (recommended)
    - BDS Production URL: ucerm.com
  - Select “University of California-Office of the President,” “Remember my selection permanently” and “Next”
  - Enter your UCOP User Name Login

- Bookmark BDS URL
  - In Mozilla Firefox, go to “Bookmarks” → “Unsorted Bookmarks” → “Organize” → “New Bookmark” → Enter “Name” field and “Location” field → Click “Add”
Module 2: BDS Tools
Part 1: Navigation (cont’d 1)

- Log off from BDS
  - Always log off from BDS when you finish your BDS session
    - Click log off on upper right corners
  - If your BDS session times out, you will need to close the entire browser and reload the bookmark in order to log on again. Otherwise, you will get an erroneous log on page.
Module 2: BDS Tools
Part 1: Navigation (cont’d 2)

- **Workflow Hierarchy**
  - BDS workflow is built on parent-child hierarchy
    - Right click to open an account, department, subdivision, or division
    - Budget is **ONLY** entered at the **ACCOUNT LEVEL**

- **Workflow States**
  - BDS workflow states indicate data status at each level
    - Below are some common workflow states

<table>
<thead>
<tr>
<th>Icons</th>
<th>States</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑️</td>
<td>Available</td>
<td>This item still requires an owner to edit or submit.</td>
</tr>
<tr>
<td>🟢</td>
<td>Reserved</td>
<td>Data has been committed for this node, but has not been submitted. The owner can edit or submit a node in this state.</td>
</tr>
<tr>
<td>🔒</td>
<td>Locked</td>
<td>The data was submitted and the approval item was locked. Data in this state is read only. If an approval item is rejected, its state returns to <strong>Reserved</strong>.</td>
</tr>
<tr>
<td>🟠</td>
<td>Incomplete</td>
<td>At least one item belonging to this item is <strong>Available</strong>, and at least one other item is in a state of <strong>Reserved</strong>, <strong>Locked</strong>, or <strong>Ready</strong>. Data in this state was aggregated. The <strong>Incomplete</strong> state applies only to review approval items.</td>
</tr>
<tr>
<td>🔴</td>
<td>Ready</td>
<td>All approval items belonging to the reviewer approval item are locked. The data is ready to be submitted to the next level in the hierarchy.</td>
</tr>
</tbody>
</table>
Migrate from Tab to Tab
- Two ways:
  - Click left or right arrows to scroll left or to scroll right for tabs
  - Click dropdown box for a list of all the available tabs

Toolbar Functions
- Take ownership only to:
  - Enter, edit, commit, submit, or reject at account budget levels
  - Submit or reject at department, subdivision or division budget levels
  - Below are some common toolbar functions

<table>
<thead>
<tr>
<th>Icons</th>
<th>Button Names</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Take Ownership</td>
<td>To edit data, you must first take ownership.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Commit</td>
<td>Committing data saves it and makes it public but does not lock it from additional changes.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Submit</td>
<td>Submitting data makes it public, locks the node from further changes, and promotes the contribution to the reviewer.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Reject</td>
<td>As a reviewer, you can reject a submitted contribution.</td>
</tr>
</tbody>
</table>

- Only one person can have ownership of an account at any given time (BDS prompts a warning message when users take away another person’s ownership)
Module 2: BDS Tools
Part 2: Demo & Exercises - Payroll
Module 2: BDS Tools
Part 2: Demo & Exercises - Payroll

Payroll Entry Tab

- There are three different sections:
  - Current Employees
  - Approved Vacancies
  - Free Entry Employees

- All fields are identical in the three sections and **REQUIRED** (unless stated otherwise below):
  - Employee Name
  - Position Nr
    - **Please note:** Position Nr is assigned in the UC Path System
    - Position Nr is required **ONLY** in the “Current Employees” and “Approved Vacancies” sections
    - **NO** Position Nr is required in the “Free Entry Employees” section, and the field is grayed out
  - Title Code and Job Title
  - Current Salary, Salary Increase, and Annual Salary
Module 2: BDS Tools
Part 2: Demo & Exercises—Payroll (cont’d 1)

- Budget Type versus Employee Class versus Sub Code
  - **Budget Type** is permanent funding or temporary funding
  - **Employee Class** is the different types of employees, such as academic: faculty, academic: non-faculty, staff: career, staff: contract, and staff: limited, etc.
    - Please note: This is a **new** field in BDS due to the UC Path implementation
  - **Sub Code** is sub 00 for academic personnel or sub 01 for all staff personnel (including career, contract, and all other temporary workers)
    - Please note: We no longer budget employees in sub 02
  - Academic employees (sub 00) can be paid on permanent funding or temporary funding
  - Career employees (sub 01) can be paid on permanent funding or temporary funding
  - Contract/temp employees (sub 01) can be paid on permanent funding or temporary funding
  - See matrix

<table>
<thead>
<tr>
<th>Employee Class (Sub Code)</th>
<th>Budget Type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Permanent Funding</td>
</tr>
<tr>
<td>Academic Employee (Sub 00)</td>
<td>✓</td>
</tr>
<tr>
<td>Staff Career Employee (Sub 01)</td>
<td>✓</td>
</tr>
<tr>
<td>Staff Contract/Temp Employee (Sub 01)</td>
<td>✓</td>
</tr>
</tbody>
</table>
Module 2: BDS Tools
Part 2: Demo & Exercises—Payroll (cont’d 2)

- Fund
- Project – This is an optional field in all three sections
- Appt FTE versus Dist % versus Total FTE
- Budget
  - Budget column = Annual Salary column * Dist %
- EMPLID
  - This is the UC Path Employee ID
  - EMPLID is ONLY required for “Current Employees” section; vacancies will NOT have EMPLID
  - Please note: This is a new field in BDS due to the UC Path implementation
- BDS ID

How to enter employees in the “Current Employees” section?
- UC Path payroll data are pre-populated one-time in BDS Payroll Entry tab’s “Current Employees” section
  - Employees with “definite” pay end dates are pre-populated as temporary budget
  - To add a new entry, select Position Nr from dropdown picklist, and this will auto-populate 8 fields (Employee Name, Title Code, Job Title, Current Salary, Employee Class, Appt FTE, EMPLID, and BDS ID); the picklist will contain Position Nr within the subdivision
  - Budget Type, Sub Code, and Fund also have dropdown picklists
  - Enter Dist % for employee
  - Other fields like Annual Salary, Budget, and Total FTE are grayed out and auto-calculated
- Position Nr picklist updated weekly (during the month of April 2016)
  - New hires or new employees to this account will be included in the dropdown picklist (within your subdivision)
Module 2: BDS Tools
Part 2: Demo & Exercises—Payroll (cont’d 3)

How to enter vacancies in the “Approved Vacancies” section?

- UC Path vacancy data are pre-populated one-time in BDS Payroll Entry tab’s “Approved Vacancies” section
  - Vacancies with “definite” pay end dates are pre-populated as temporary budget
  - To add a new entry, select Position Nr from dropdown picklist, and this will auto-populate 2 fields (Title Code and Job Title); the picklist will contain Position Nr within the department
  - Budget Type, Sub Code, and Fund also have dropdown picklists
  - Enter Dist % for position
  - Other fields like Annual Salary, Budget, and Total FTE are grayed out and auto-calculated
- Position Nr picklist is updated weekly (during the month of April 2016)
  - New vacancies to this account will be included in the dropdown picklist (within the specific department and NOT within your subdivision)
- Type in employee vacancy
  - Common vacancy name format (to help you track the position):
    “Replace [First Name] [Last Name]” (e.g., “Replace John Smith”)
- Enter Current Salary
- Select Employee Class from dropdown picklist
- Enter Appt FTE
- Leave EMPLID blank because vacancies have NO EMPLID
- Select BDS ID from dropdown list
  - This is a temporary ID in BDS for tracking purposes
  - Use XXXXXXXA01, XXXXXXXA02, etc. (where XXXXXXX is the account number)
How to enter employees or vacancies in the “Free Entry Employees” section?

- Position Nr is grayed out
- Select Job Title from dropdown picklist, and this will auto-populate Title Code
- Select BDS ID from dropdown list
  - This is a temporary ID in BDS for tracking purposes
  - Use XXXXXXV01, XXXXXXV02, etc. (where XXXXXX is the account number)

<table>
<thead>
<tr>
<th>Employee Class (Sub Code)</th>
<th>BDS ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Academic Employee (Sub 00)</td>
<td>XXXXXXV01, XXXXXXV02, etc.</td>
</tr>
<tr>
<td>Staff Career Employee (Sub 01)</td>
<td>XXXXXXV01, XXXXXXV02, etc.</td>
</tr>
<tr>
<td>Staff Contract/Temp Employee (Sub 01)</td>
<td>XXXXXXV01, XXXXXXV02, etc.</td>
</tr>
</tbody>
</table>

- Type in employee name or employee vacancy
  - Common vacancy name format (to help you track the position):
    “Replace [First Name] [Last Name]” (e.g., “Replace John Smith”)
- Enter Current Salary
- Select Employee Class from dropdown picklist
- Enter Appt FTE
- Leave EMPLID blank

Different from both “Current Employees” and “Approved Vacancies” Sections

Similar to only “Approved Vacancies” Section
Module 2: BDS Tools
Part 2: Demo & Exercises—Payroll (cont’d 5)

Similar to both sections

- Budget Type, Sub Code, and Fund also have dropdown picklists
- Enter Dist % for position
- Other fields like Annual Salary, Budget, and Total FTE are grayed out and auto-calculated

How to delete employees or vacancies in the “Current Employees,” “Approved Vacancies” and “Free Entry Employees” sections?

- Three ways:
  - ONLY zero out dist % field because this will zero out budget
  - Blank (or zero) out ALL the fields in the row
  - Highlight the entire row and press the “delete” key on your keyboard
Module 2: BDS Tools
Part 2: Demo & Exercises—Payroll (cont’d 6)

Payroll Entry Tab Examples

- Example 1 – Full-time career employee David Scott on permanent funding with an equity increase effective July 1, 2016 for a salary of $60,000 (use fund number 00001 and job title Project Policy Anl 2)

- Example 2 – Full-time career employee Neil Armstrong reflected on permanent funding but will be on temporary funding with a salary of $130,000 (use fund number 69085 and job title Exec Advisor Mgr 2)

- Example 3 – Full-time contract employee Bonnie Dunbar on permanent funding with a salary of $80,000 (use fund number 69085 and job title Project Policy Anl 4)

- Example 4 – Department recruiting a full-time career position to replace John Young on permanent funding with a salary of $50,000 (use fund number 69085 and job title Admin Ast 3)
  - Hints: Remember to use “Replace John Young” in Employee Name field and XXXXXXXA01 (or XXXXXXXA02, etc.) in BDS ID field

- Example 5 – Full-time career employee Catherine Coleman on permanent funding with a salary of $60,000 is retiring on June 30, 2016 and will create career vacancy starting July 1, 2016 (use 95% on fund number 69085, 5% on fund number 69763, and job title Project Policy Anl 2)
  - Hints: Remember to use “Replace Catherine Coleman” in Employee Name field and XXXXXXXV01 (or XXXXXXXV02, etc.) in BDS ID field
Payroll Entry Tab Examples (Answer)

- Example 1 – Full-time career employee David Scott on permanent funding with an equity increase effective July 1, 2016 for a salary of $60,000 (use fund number 00001 and job title Project Policy Anl 2)

- Example 2 – Full-time career employee Neil Armstrong reflected on permanent funding but will be on temporary funding with a salary of $130,000 (use fund number 69085 and job title Exec Advisor Mgr 2)
  - Step 1: Keep the entire pre-populated Neil Armstrong row in the Payroll Entry Tab’s “Current Employees” section
  - Step 2: Change Neil Armstrong’s permanent funding to temporary funding
Module 2: BDS Tools
Part 2: Demo & Exercises—Payroll (cont’d 8)

- Example 3 – Full-time contract employee Bonnie Dunbar on permanent funding with a salary of $80,000 (use fund number 69085 and job title Project Policy Anl 4)
  - Step 1: Keep the entire pre-populated Bonnie Dunbar row in the Payroll Entry Tab’s “Current Employees” section
    Reminder: Bonnie Dunbar pre-populated as temporary budget because she has a definite pay end date as a contract employee
  - Step 2: Change Bonnie Dunbar’s temporary funding to permanent funding

- Example 4 – Department recruiting a full-time career position to replace John Young on permanent funding with a salary of $50,000 (use fund number 69085 and job title Admin Ast 3)
  - Step 1: Keep the entire pre-populated career vacancy row in the Payroll Entry Tab’s “Approved Vacancies” section
  - Step 2: Enter Employee Name as “Replace John Young”
  - Step 3: Enter $50,000 for Current Salary
  - Step 4: Select “Staff: Career” for Employee Class
  - Step 5: Enter 1 for Appt FTE
  - Step 6: Select “XXXXXXXXA01” for BDS ID
Example 5 – Full-time career employee Catherine Coleman on permanent funding with a salary of $60,000 is retiring on June 30, 2016 and will create a career vacancy starting July 1, 2016 (use 95% on fund number 69085, 5% on fund number 69763, and job title Project Policy Anl 2)

- Step 1: Delete the two pre-populated Catherine Coleman rows in the Payroll Entry Tab’s “Current Employees” section because Catherine Coleman already retired by July 1, 2016 in FY16-17
- Step 2: Enter the two vacancy rows shown below in the Payroll Entry Tab’s “Free Entry Employees” section using XXXXXXV01 for BDS ID
Module 2: BDS Tools
Part 2: Demo & Exercises—Payroll (cont’d 10)

Payroll Summary Tabs

- There are two Payroll Summary tabs
  - Payroll Summary by Org
  - Payroll Summary by Employee ID

- How are the two Payroll Summary tabs different?
  - Payroll Summary by Org
    - Listed by budget types (permanent or temporary) and sub codes (sub 00, sub 01, or sub 02)
    - On higher hierarchy levels (not account budget level), will be able to see by Org (div, subdivision, and departments)
  - Payroll Summary by Emp ID
    - Listed by employee ID
    - Intended for reconciling payroll budgets by employee
      For example, if an employee is split funded by permanent/temporary funding, both entries will be sorted and listed together by the employee name (from Payroll Entry tab’s “Current Employees” section) or by employee ID (from Payroll Entry tab’s “Approved Vacancies” and “Free Entry Employees” sections)
How are the two Payroll Summary tabs similar?

- All the data entered in the Payroll Entry tab flow into both Payroll Summary by Org and Payroll Summary by Emp ID
- Total Funds column expands to fund groups (restricted and unrestricted) and to individual fund numbers
- Annual Salary Program
  - **Restricted funding**: Auto-calculated 3% salary increases for all employee classes: Academic personnel sub 00, staff career personnel sub 01, and staff contract/temp personnel sub 01, etc. on permanent funding
  - **Centrally Controlled Restricted funding (funds: 68614, 69590, 69593, 69700, 69705, 69740, and 69763)** and Unrestricted funding: BDS allocation in August/September 2016 based on actuals for all employee classes: Academic personnel sub 00, staff career personnel sub 01, and staff contract/temp personnel sub 01, etc. on permanent funding
- Lump Sum Salary can be entered in these two tabs
  - Lump Sum Salary (such as turnover savings, etc.), is recorded in sub 02
- 39.2% benefits auto-calculated on all employee salary budgets (including academic personnel sub 00, staff career personnel sub 01, staff contract/temp personnel sub 01, all Annual Salary Program increases, and sub 02 Lump Sum Salary amounts)
- Even though the Lump Sum Salary field is available in both Payroll Summary tabs, you only need to enter amounts in ONE of the tabs because the data will flow to the other tab
  - Although both tabs work, we recommend entering Lump Sum Salary in the Payroll Summary by Org tab
Module 2: BDS Tools
Part 2: Demo & Exercises—Payroll (cont’d 12)

- Payroll Summary Tab Example
  - Example 6 – $200 stipend budget on permanent funding (use fund number 69085)
    - Hint: Remember to use Lump Sum Salary

- Payroll Summary Tab Example (Answer)
  - Example 6 – $200 stipend budget on permanent funding (use fund number 69085)
    - Step 1: Enter $200 in the Payroll Summary by Org tab’s permanent funding section and “Lump Sum Salary” row under unrestricted fund 69085
Module 2: BDS Tools  
Part 2: Demo & Exercises—Payroll (cont’d 13)

Payroll Report Divisional Tab

- The Payroll Report Divisional Tab contains two reports
  - Payroll Report Divisional – Summary
  - Payroll Report Divisional – Detail

- How are the two Payroll Report Divisional different?
  - Payroll Report Divisional – Summary
    - This has all the same information as the Payroll Summary by Org tab with a more user friendly format
  - Payroll Report Divisional – Detail
    - This has all the same information as the Payroll Summary by Org tab plus these additional fields: Employee Class, Position Nr, Current Salary, Salary Increase, Job Title, Job Code, Project, Appt FTE, Total FTE, EMPLID, and Employee Entry
How are the two Payroll Reports Divisional similar?

- Both have dropdown boxes to view different fiscal years
- Both are available at all hierarchy levels (accounts, departments, subdivisions, divisions, and org)
- **Both can export to Excel**
  - Exports come with all division, subdivision, department, account fields as shown in the BDS system
  - When you export, both summary and detail reports are available at once, so you only need to export once.
  - There are hidden columns on the exports that can be unhidden in Excel
  - If there are technical difficulties with exporting, please make sure:
    1. that your **pop-up blocker is turned off**
    2. that you added the BDS URL (http://ucerm.com) to your browser’s trusted sites
    3. that you **ONLY use the “Snapshot to Excel”** option when exporting to Excel; please do not use “Slice to Excel”

Blue circle on upper left corner ➔ “Export” ➔ “Snapshot to Excel”
Module 2: BDS Tools
Part 2: Demo & Exercises—Non-Payroll
Supplies & Expense Permanent & Temporary Tabs

- There are two Supplies & Expense tabs
  - Supplies & Expense Permanent tab
  - Supplies & Expense Temporary tab

- How are the two Supplies & Expense tabs different?
  - Supplies & Expense Permanent tab
    - For non-payroll expenses on permanent funding only
  - Supplies & Expense Temporary tab
    - For non-payroll expenses on temporary funding only
      - Estimated restricted fund balance of the current year (AKA: carryforwards) that will be used in the next FY
      - Any one-time funding
      - Estimated “next FY” portion of multi-year project funding
How are the two Supplies & Expense tabs similar?

- Both tabs have the same four main columns:
  1. “Next Year Budget” – this column is where you enter next year’s S&E budget (FY16-17)
  2. 3 reference columns to help you plan your budget for next year:
    1. “Current Year” – this column shows the budget for this current year (FY15-16)
    2. “Current Year Actual Q1+Q2” – this column shows the actual expenditures for quarter 1 and quarter 2 of this year (FY15-16)
    3. “Prior Year Expenditures” – this column shows the actual expenditures for the entire year of last year (FY14-15)

- Both Supplies and Expense tabs are for non-payroll expenditures
  1. Non-payroll expense subs are: 03, 04, 05, 07, 08, 09, and overhead 9H
    (Payroll expenses subs are: 00, 01, 02, and benefits 06)
  2. IMPORTANT NOTES:
    1. **sub 08 is for pass-through ONLY**, so please DO NOT park unused budget here if it is not a pass-through
    2. **when using sub 09 for recharge operations**, please remember to account for all non-payroll expenses and all personnel expenses (such as sub 00, sub 01, sub 02, and benefits sub 06)
For both tabs, budget is entered at the expense category level by fund (where Total Funds column expands to fund groups and to individual fund numbers)

- For more detailed budgeting (such as allocation of budget by project), object codes are also available

General Auto Employment Liability (GAEL) is calculated based on total salary budget (including academic personnel sub 00, staff career personnel sub 01, staff contract/temp personnel sub 01, and Lump Sum Salary amounts sub 02, etc.) and auto-populated in sub 03 Insurance expense category

- GAEL rate is budgeted at .64% in BDS for FY16-17

<table>
<thead>
<tr>
<th>03 Insurance</th>
<th>2,390</th>
<th>2,708</th>
<th>1,590</th>
<th>3,451</th>
</tr>
</thead>
<tbody>
<tr>
<td>03-3380 INSURANCE</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>03-3385 INSURANCE/GENERAL AND AUTO</td>
<td>1,195</td>
<td>1,354</td>
<td>795</td>
<td>1,725</td>
</tr>
<tr>
<td>03-3390 INSURANCE/EMPLOYMENT PRACTICES</td>
<td>1,195</td>
<td>1,354</td>
<td>795</td>
<td>1,725</td>
</tr>
<tr>
<td>03-3395 MEDICAL MALPRACTICE INSURANCE</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>03-7256 INSURANCE</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

- Non-Payroll Examples

- Example 7 – $1,000 consultant budget on permanent funding (use fund number 69085)

- Example 8 – Full-time career employee Ellen Baker currently on permanent funding with fund 69085 but will be on a 1 year project in FY16-17 with 1X temporary funding on fund 00001 (use $50,000 salary and job title Admin Ast 3). The department will use the available $50,000 plus benefits on fund 69085 for supplies and expenses – temp labor budget

  - Hints: Benefits rate remains at 39.2%, and this is a temporary change in budget type
Module 2: BDS Tools
Part 2: Demo & Exercises—Non-Payroll (cont’d 3)

- Non-Payroll Examples (Answer)
  
  Example 7 – $1,000 consultant budget on permanent funding (use fund number 69085)

  ![BDS Training Divisional | Reserved | 900001 ACCOUNT 1 - Mozilla Firefox](image)

  - Example 8 – Full-time career employee Ellen Baker currently on permanent funding with fund 69085 but will be on a 1 year project in FY16-17 with 1X temporary funding on fund 00001 (use $50,000 salary and job title Admin Ast 3). The department will use the available $50,000 plus benefits on fund 69085 for supplies and expenses – temp labor budget
    - Step 1: Keep the entire pre-populated Ellen Baker row in the Payroll Entry Tab’s “Current Employees” section
**Module 2: BDS Tools**  
**Part 2: Demo & Exercises—Non-Payroll (cont’d 4)**

- **Step 2:** Enter another Ellen Baker row in the Payroll Entry Tab’s “Current Employees” section with temporary funding and -1.0000 dist % for fund 69085 (see highlighted row below)

![Payroll Entry Tab](image1)

- **Step 3:** Enter one more Ellen Baker row in the Payroll Entry Tab’s “Current Employees” section with temporary funding and 1.0000 dist % for fund 00001 (see highlighted row below)

![Payroll Entry Tab](image2)
Step 4: Enter unused temporary budget of $70,165 for fund 69085 and temp labor expense category

**Calculation of $70,165:**

$50,000 salary * 39.2% benefits rate = $19,600 benefits

$19,600 benefits + $50,000 salary = **$69,600** total
Module 2: BDS Tools
Part 2: Demo & Exercises–Summary (Read-Only) Tabs
Account Budget Tabs

- There are two Account Budget Tabs
  - Account Budget Tab
  - Account Budget Report Tab

- Account Budget Tab
  - All payroll budget and supplies & expense budget entries flow here
    - No data entry is required
  - This tab is for you to review your proposed budget
  - This tab also shows the budget change between total current fiscal year (FY15-16) and next fiscal year (FY16-17) by the following four categories:
    - Salary Increases row—does not include increases from the Annual Salary Program; this number is from the Payroll Entry tab
    - Annual Salary Program – 3% auto-calculated for restricted funding and allocation based on actuals in August/September 2016 for centrally restricted and unrestricted funding
      This number is from the Payroll Summary by Org tab
    - Benefits Increase – this number = benefits rate change * total next FY salary
    - Other Budget Adjustments – all other adjustments other than Salary Increases, Annual Salary Program, and Benefits Increase

- Once you have reviewed everything and all numbers look good, press the “submit” button on the toolbar for next hierarchy level’s review and approval
Module 2: BDS Tools
Part 2: Demo & Exercises—Summary (Read-Only)
Tabs (cont’d 1)

- **Account Budget Report Tab**
  - This tab has the same information as the Account Budget Tab with a more user friendly format
  - This tab is able to be viewed in 2 ways:
    - Summary
    - Detail (automatically expands to expense category level)
    - To switch between summary form and detail form, select “Summary” or “Detail” from dropdown box, then click on the “Rebuild Active Forms” button on the toolbar to refresh the data.

- This tab can export to Excel
  - Exports can be done on the summary format and on the detail format
  - Same way to export: Blue circle on upper left corner ➔ “Export” ➔ “Snapshot to Excel”
Module 2: BDS Tools
Part 2: Demo & Exercises—Summary (Read-Only)
Tabs (cont’d 2)

- Budget Office 1 Tabs
  - There are two Budget Office 1 Tabs
    - Budget Office 1 Tab
    - Budget Office 1 Report Tab
  - Budget Office 1 Tab
    - All payroll budget and supplies & expense budget entries flow here
      - No data entry is required
    - Budget Office 1 tabs are different than the Account Budget tabs because the Budget Office 1 tabs include permanent and temporary adjustments made by the UCOP Budget Office
      - Account Budget tabs only have proposed budget and do not include any UCOP Budget Office adjustments
      - This tab is for you to review all of the permanent and temporary adjustments made to your proposed budget by the UCOP Budget Office
  - Budget Office 1 Report Tab
    - This tab has the same information as the Budget Office 1 Tab with a more user friendly format
Similar to the Account Budget Tab, the Budget Office 1 Report Tab is able to be viewed in 2 ways:

- Summary
- Detail (automatically expands to expense category level)
- To switch between summary form and detail form, select “Summary” or “Detail” from dropdown box, then click on the “Rebuild Active Forms” button on the toolbar to refresh the data.

This tab can export to Excel

- Exports can be done on the summary format and on the detail format
- Same way to export: Blue circle on upper left corner → “Export” → “Snapshot to Excel”
Module 2: BDS Tools
Part 2: Demo & Exercises—Summary (Read-Only)
Tabs (cont’d 4)

- **Budget Office 2 Tab**
  - All payroll budget and supplies & expense budget entries flow here
    - No data entry is required
  - This tab only shows permanent budget and FTE
    - There is no temporary budget on this tab
    - There is only FTE on sub 00 and sub 01 (not sub 02)
  - This tab is for you to:
    - Compare permanent budget changes between current fiscal year (FY15-16) and next fiscal year (FY16-17) by all sub codes
      - The Difference column is automatically calculated for you
    - Compare FTE changes between current fiscal year (FY15-16) and next fiscal year (FY16-17) only on sub 00 and sub 01
      - The FTE Difference column is automatically calculated for you
  - There is no Budget Office 2 Report Tab
Module 2: BDS Tools
Part 2: Demo & Exercises–
Budget Distributions & Additional System Features
Module 2: BDS Tools
Part 2: Demo & Exercises–Budget Distributions & Additional System Features

☑ Additional Ways to Distribute Permanent & Temporary Budgets
   – There are two additional ways to distribute budgets
     ➢ By Project
     ➢ By Quarter

   – Budget Distribution by Project
     ➢ Use Payroll Entry tab Project column for employee specific salary budgets
     ➢ Use Supplies & Expense Perm Proj tab and Supplies & Expense Temp Proj tab for Lump Sum Salary, Annual Salary Program, and benefits
     ➢ Use Supplies & Expense Perm Proj tab and Supplies & Expense Temp Proj tab for supplies and expense budgets
Module 2: BDS Tools
Part 2: Demo & Exercises—Budget Distributions & Additional System Features (cont’d 1)

– Budget Distribution by Quarter
  Ø Use Distribution Permanent tab and Distribution Temporary tab
    ▪ The default setting distributes the annual budget by 25% quarterly (no action is needed); HOWEVER, you can enter the desired quarterly distribution in Q1, Q2, and Q3, and Q4 is auto-calculated with the difference
    ▪ The quarterly distribution is entered at the fund and expense category levels
    ▪ We highly recommend using the quarterly distribution tabs to allow more accurate budget to actual reporting
Additional System Features

Forecast: There are two Forecast Tabs

- Forecast Tab
- Forecast Report Tab

Forecast Tab

- All approved BDS budgets, GL actuals, interlocation transfers (ITF), encumbrances, and memo liens for the current year flow here
- Total funds expands down to fund groups (restricted and unrestricted) and to individual fund numbers
- The sub codes expand down to expense categories with an adjustment (ADJ) row for each expense category
There are two forecast methods available (select different methods from “Forecast Method” dropdown box):

- **Method 1**: No pre-populated forecast data for future months; only blank fields on the ADJ expense category rows are available for manual forecast entries.
Module 2: BDS Tools
Part 2: Demo & Exercises—Budget Distributions & Additional System Features (cont’d 4)

- Method 2: System pre-populated forecast amounts for future months by spreading the remaining budget balance equally over the remaining months of the fiscal year; users can enter manual adjustments to the pre-populated amounts on the ADJ expense category rows.
Forecast Report Tab

- This tab has the same information as the Forecast Tab with a more user-friendly format.
- To switch between Forecast Method 1 and Forecast Method 2, select “Forecast Method 1” or “Forecast Method 2” from the dropdown box.
- This tab can export to Excel:
  - Exports can be done on “Forecast Method 1” and “Forecast Method 2”.
  - There are hidden columns (such as the months) on both the exports that can be unhidden in Excel.
  - Same way to export: Blue circle on upper left corner → “Export” → “Snapshot to Excel”
Module 2: BDS Tools
Part 2: Demo & Exercises—Budget Distributions & Additional System Features (cont’d 6)

- Reset Features
  - Click on blue circle → Reset Data
    - this is used when you want to reset all the cell numbers to the last saved (committed) version in the level you are in
  - Click on blue circle → Reset View → Reset Current View
    - this is used when you want to reset the view dimensions (for example, Columns: division_fund_1 [division_fund]) to the default version in the tab and in the level you are in
  - Click on blue circle → Reset View → Reset All Views
    - this is used when you want to reset the view dimensions to the default version in ALL the tabs and in the level you are in
  - Click on blue circle → Reset View → Reset Tabs
    - this is used when you want to reset the tabs to the default version in the level you are in
  - Click on blue circle → Reset View → Reset Both Views and Tabs
    - this is used when you want to reset both the view dimensions and the tabs to the default version in the level you are in
Annotations/Comments

- Able to add comments at cell level in tabs
  - Right click on any cell (white or gray color) → Add Comment → Type in your comment
  - The comment will be time stamped with your user ID and **cannot be deleted**
  - The comment is stored as history

- Able to add comments (and attachments) at node level in workflow hierarchy
  - Click on the Commentary Status dropdown box to prompt the “Add Comment” folder, then click on the “Add Comment” folder to add comments or attachments.
  - The comment will be time stamped with your user ID and **cannot be deleted**
  - The comment and attachment will be saved for 1 fiscal year only
Ownership Management

- Able to view who the current owner is at node level in workflow hierarchy
- If erroneously taken ownership at the account, department, subdivision, or division level, user can release ownership at the node level in the workflow hierarchy
  - Right click on the level you want to release, then click release
  - Only one person can have ownership of an account at any given time
Module 2: BDS Tools
Part 2: Demo & Exercises—Summary

Recap

• Payroll
  o Payroll Entry Tab
    ❖ Current Employees section
    ❖ Approved Vacancies section
    ❖ Free Entry Employees section
  o Payroll Summary Tabs
    ❖ Payroll Summary by Org
    ❖ Payroll Summary by Emp ID
  o Payroll Report Divisional Tab
    ❖ Payroll Report Divisional Tab – Summary
    ❖ Payroll Report Divisional Tab – Detail

• Non-Payroll
  o Supplies & Expense Tabs
    ❖ Supplies & Expense Permanent Tab
    ❖ Supplies & Expense Temporary Tab

• Summary (Read-Only) Tabs
  o Account Budget Tabs
    ❖ Account Budget Tab
    ❖ Account Budget Report Tab
  o Budget Office 1 Tabs
    ❖ Budget Office 1 Tab
    ❖ Budget Office 1 Report Tab
  o Budget Office 2 Tab

• Budget Distributions by Project & by Quarter

• Additional System Features
Module 2: BDS Tools

Part 3: Reports
Module 2: BDS Tools
Part 3: Reports

☐ BDS Reports are Helpful for Budget Planning
   – To access:
     ➢ “Public Folders” tab → click on “Cognos BDS Reports” OR directly click on the “Cognos BDS Reports” tab
   – Reports are grouped into 5 Folders:
     ➢ Budget to Actual Reports
     ➢ Summary Reports
     ➢ Budget Planning Reports
     ➢ Object-Code List
     ➢ BDS Adhoc Package
## Module 2: BDS Tools

### Part 3: Reports (cont’d 1)

#### Sample BDS Reports

<table>
<thead>
<tr>
<th>Functions</th>
<th>BDS Reports</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget to Actual Reports</td>
<td>Comprehensive Budget Variance Report</td>
<td>BDS budget vs. GL budget and actual</td>
</tr>
<tr>
<td>Budget to Actual Reports</td>
<td>Management Exception Report</td>
<td>GL Balance deficit monitoring (YTD appropriation vs. YTD actual)</td>
</tr>
<tr>
<td>Budget to Actual Reports</td>
<td>Variance Report (CY Budget to CY Actuals)</td>
<td>BDS budget vs. GL actual</td>
</tr>
<tr>
<td>Summary Reports</td>
<td>Summary Report – Actual</td>
<td>GL actual by fiscal year or by quarter</td>
</tr>
<tr>
<td>Summary Reports</td>
<td>Summary Report – Budget</td>
<td>BDS budget by fiscal year or by quarter</td>
</tr>
<tr>
<td>Budget Planning Reports</td>
<td>Budget Submission Tracking Report</td>
<td>BDS budget year-on-year change comparison (multi-division-subdivision-account-account)</td>
</tr>
<tr>
<td>Budget Planning Reports</td>
<td>Budget Comparison Report</td>
<td>BDS budget year-on-year change comparison (permanent and temporary budget breakdown)</td>
</tr>
<tr>
<td>Object-Code List</td>
<td>Object-Code List</td>
<td>Object code mapping to all the expense categories</td>
</tr>
</tbody>
</table>
Module 2: BDS Tools
Part 3: Reports (cont’d 2)

– Variance Report
  ➢ This report shows BDS budget versus GL expenses
  ➢ It can be by organization or by fund
  ➢ It can also be by expense categories or by sub code levels
    ▪ This report allows drill-down for both the expense categories and sub code levels
  ➢ The BDS budget data is refreshed nightly, but the GL expenses on this report are loaded monthly (one or two days after month-end close)

– Summary Report – Actual
  ➢ This report shows GL expenses by fiscal year or by fiscal quarter
  ➢ It can be by organization or by fund
  ➢ It can also be by expense categories or by sub code levels
    ▪ This report allows drill-down for both the expense categories and sub code levels
  ➢ It is refreshed monthly (one or two days after month-end close)

– Budget Comparison Report
  ➢ This report shows BDS budget year-on-year change comparison
  ➢ It has total budget, permanent budget, and temporary budget breakdown
  ➢ It is by organization
  ➢ It can be by expense categories or by sub code levels
    ▪ This report allows drill-down for both the expense categories and sub code levels
  ➢ It is refreshed nightly
Module 2: BDS Tools
Part 3: Reports (cont’d 3)

– Object-Code List
   This report shows all the object codes mapped to all the expense categories
     The report allows all the expense categories to be viewed at once
     The report also allows each of the expense categories to be viewed one at a time

– Report Exports
   All reports can be exported to Excel
     For Excel exports, go to upper right corner, click on “HTML” dropdown arrow→“View in Excel Options”→“View in Excel 2007 Format”
Module 2: BDS Tools
Part 3: Reports (cont’d 4)

- BDS Ad Hoc Package
  - All data (including BDS budgets, GL actuals, UCLA permanent budgets, BDS FTE, etc.) used to create BDS reports are here
  - Users can run queries using shared queries
    “Public Folders” tab → click on “Cognos BDS Reports” → click on “BDS Adhoc Package”

- Users also has the option to build their own queries according to their own filters and criteria
  “Public Folders” tab → click on “Cognos BDS Reports” → click on “BDS Adhoc Package” → go to upper right hand corner and click on “Launch” dropdown box → click on “Query Studio”

- BDS budget data is refreshed nightly, and all GL data (actuals, ITFs, encumbrances, etc.) is refreshed after month-end close
Module 2: BDS Tools
Part 4: Maintenance
Module 2: BDS Tools
Part 4: Maintenance

- Data Load & Refresh
  - Payroll/Vacancy Data
    - Data on new hires or new employees in the account (within your subdivision) will be refreshed and included in the Payroll Entry tab Current Employees section’s picklist weekly in the month of April 2016.
    - Data on new vacancies in the account (within your department) will be refreshed and included in the Payroll Entry tab Approved Vacancies section’s picklist weekly in the month of April 2016.
  - BDS Budget Entries
    - All BDS budget data will be reflected the next business day on your BDS reports.
  - GL Expenses
    - All GL data will be loaded monthly (one or two days after month-end close) to BDS reports.

- Organizational Changes
  - BDS will reflect the organization change once the organizational change is in the UCLA financial system.
    - Examples: reorganization, new dept code, dept code moved to another subdivision, new accounts, fund title changed, etc.
Module 2: BDS Tools
Part 4: Maintenance (cont’d 1)

- New Fund Setups/Dummy Funds
  - If you are waiting for a new fund number to be set up, please use our BDS dummy fund temporarily
    - All BDS accounts are already linked to one dummy fund (fund 00001)
    - Contact us if you need additional dummy funds
    - Contact us when you received the new fund number, so we can migrate the budget in BDS
Module 3: BDS Help
Module 3: BDS Help
Technical Assistance

Who can I go to for BDS assistance?

- All Budget Office Coordinators
- BDS Tool Support
  - Pei-Ru Chao
  - Cindy Lau
  - Angel Warren
- BDS Office Hours
  - Tuesdays and Thursdays between 10 AM – 12 PM in the month of April 2016
  - At UCOP Budget Office 9th floor

Who can I go to for log on issues?

- UC ERM Service Desk (erm@ucop.edu) and cc: BDS Tool Support (Pei-Ru Chao, Cindy Lau, and Angel Warren)
- Always report issues with a screenshot if available
FY16-17 Budget Assumptions

- Annual Salary Program
  - **Restricted funding**: Auto-calculated 3% for all employee classes in sub 00 and 01
  - **Centrally Controlled Restricted funding** (funds: 68614, 69590, 69593, 69700, 69705, 69706, 69740, and 69763) and **Unrestricted funding**: BDS allocation in August/September 2016 based on actuals for all employee classes in sub 00 and 01

- 39.2% Benefit Rate Budgeted in BDS for FY16-17
  - Changed from FY15-16
  - Auto-calculated in BDS for all employee classes (sub 00 and sub 01), all Annual Salary Program, and sub 02 Lump Sum Salary amounts

- .64% Budgeted GAEL Rate in BDS for FY16-17
  - Calculated based on total salary budget (sub 00, 01 and 02) and auto-populated in BDS in supplies and expenses sub 03’s Insurance expense category for both permanent funding and temporary funding

Budget Targets

- Approximately the end of March 2016

FY16-17 BDS Budget Submission Timeline

- April 30th to the UCOP Budget Office
Module 4: Questions & Answers